
OPTIMIZING 
FOR SPEED & 
PRODUCTION
with LightBurn



SETUP
LightBurn = Design and control for lasers. 

Download free trial of LightBurn at: 
lightburnsoftware.com

Follow along with the slides via
LightBurn Forum > Resources,
or this QR code

• We will be moving quickly, so it may be tricky to follow along 
in the software, 

• I have uploaded this slide deck so you can reference it at 
your own pace. 

• Show how to find on Forum



HI! I’M BILLIE RUBEN!
● Australian
● Maker of many kinds
● Makerspace & Community Facilitator
● Content Team at LightBurn Software:

○ Documentation
○ YouTube Videos
○ User Experience
○ Graphic Design



WHY OPTIMIZE?
● Costs are rising
● But the odds are in your favor 

• Material getting more expensive but congrats! 

• Laser remains one of the best ways to make money as a 
maker/ small to medium business. 

• How do I know? Australia has highest minimum wage on 
earth & extremely high shipping - 
unavoidable costs, yet every 3rd stall at craft markets is a 
laser business.



● Depends on goals/design
● I will demo many today
● + Link to extra resources

Including our documentation
● Book symbol = more info

HOW WE WILL DO IT:

•Many ways to speed up production, what applies depends 
on goals.

•We will start with some simpler ones, you may know these 
already, and get more complex.

•Whenever you see the book symbol, I have included links to 
relevant documentation, in show notes of the presentation.



Concepts 



MAXIMIZE SPEED?
● Sometimes, but it’s complicated
● Let’s return to this question

• Many folk think to make my jobs quicker, I just need to 
speed up.

• It’s intuitive, like driving in a car - minimize travel distance, 
and go as fast as you can, right?

• But is it always faster? 

• In a car turning right can save you time, even though you 
travel a longer distance. 

• We don’t have traffic in Lasers, so this particular example 
doesn’t apply, but there are some different instances where 
more speed doesn’t mean a quicker job, and we will explore 
those today. 

• Let’s return to speed question later. 



● Always Preview Job.
● Black = Cutting/Engraving = Laser ON
● Red = Travel/Rapid Moves = Laser OFF

(Preview > Show traversal moves)
● Note the time estimates

PREVIEW JOBS

• Always Preview your jobs, both for seeing how long it will 
take, but also to spot any accidents before you cut into your 
material. 

• Rapid and Cut move distances are listed below preview. 

• If you don’t see red, click on “Show Traversal Moves”

More Info: 

• Preview Window (includes videos): 
https://docs.lightburnsoftware.com/latest/Reference/Previe
w/#



If Preview Inaccurate: 
● Edit>Device Settings> Additional Settings 
● “Read from Controller” or: 

manually adjust “Simulation Settings”

PREVIEW ACCURACY

• “Find my laser” when adding a machine pulls device 
settings from machine. 

• If you find the preview estimates are very different to your 
real-life job time, you can adjust them.

• Change Simulation Settings via Edit>Device Settings> 
Additional Settings 

• Changing Sim Settings does NOT change anything on your 
controller or your job settings. Just the preview. 

More Info

• Video: Get Accurate Job Times in LightBurn:
https://www.youtube.com/watch?v=s1jCqB233N0

• Device Settings:
https://docs.lightburnsoftware.com/latest/Reference/Device
Settings/AdditionalSettings/

https://www.youtube.com/watch?v=s1jCqB233N0
https://docs.lightburnsoftware.com/latest/Reference/DeviceSettings/AdditionalSettings/
https://docs.lightburnsoftware.com/latest/Reference/DeviceSettings/AdditionalSettings/


MINIMIZE DISTANCE
● Minimize how far the laser has to move
● Both of laser ON & OFF
● Lots of ways to do this

● Generally the less red and black we see in the preview 
the quicker the job will be.



AVOID RASTER ENGRAVINGS
Line Layers travel far less,

follow the contour/perimeter
Image, Fill, or Offset Layers 

use many lines to ‘color in’ area

• Two types of ways a laser can move, 

• either by tracing along vector lines, 

• or by filling in an area by ‘scanning’ back and forth. 

• Scanning is used for engraving images and filling closed 
vector shapes.

• Scanning takes far more time because it has to move much 
farther. 

Further reading:

• Layer modes: 
https://docs.lightburnsoftware.com/latest/Explainers/LayerM
odes/

• Image vs Vector: 
https://docs.lightburnsoftware.com/latest/Explainers/Images
VsVectors/

• Closed vs Open Shapes: 
https://docs.lightburnsoftware.com/latest/Explainers/OpenCl

https://docs.lightburnsoftware.com/latest/Explainers/LayerModes/
https://docs.lightburnsoftware.com/latest/Explainers/LayerModes/
https://docs.lightburnsoftware.com/latest/Explainers/ImagesVsVectors/
https://docs.lightburnsoftware.com/latest/Explainers/ImagesVsVectors/
https://docs.lightburnsoftware.com/latest/Explainers/OpenClosedShapes/


• osedShapes/

•

https://docs.lightburnsoftware.com/latest/Explainers/OpenClosedShapes/


● Line Mode isn’t cut mode
● Difference between a cut line and 

a score (engrave/mark) line is your settings. 
● Lower power and increase speed to score.

CUT VS SCORE



ADJUST THE DESIGN

Engrave with lines, not fills: 

●
You can score a line. A Lot of folk think of line 
operations as a ‘cut’, but they don’t have to be. 
With lower power or higher speed, you can avoid 
cutting all the way through, and instead just score a 
line.

If you design with this in mind you can DRASTICALLY 
reduce the time of your jobs. 

Depends on design. Sometimes you need a fill, e.g if 
you’re removing an area of material, but often you 
don’t. Often an outline will do. 

Further reading:



• Layer modes: 
https://docs.lightburnsoftware.com/latest/Explainers/LayerModes/

• Image vs Vector: 
https://docs.lightburnsoftware.com/latest/Explainers/ImagesVsVe
ctors/

• Closed vs Open Shapes: 
https://docs.lightburnsoftware.com/latest/Explainers/OpenClosed
Shapes/

https://docs.lightburnsoftware.com/latest/Explainers/LayerModes/
https://docs.lightburnsoftware.com/latest/Explainers/ImagesVsVectors/
https://docs.lightburnsoftware.com/latest/Explainers/ImagesVsVectors/
https://docs.lightburnsoftware.com/latest/Explainers/OpenClosedShapes/
https://docs.lightburnsoftware.com/latest/Explainers/OpenClosedShapes/


SPEED UP TEXT

• This also applies to Text. 

• Engraving a word takes a lot longer than outlining it. 

• And outlining a word takes longer than a single line font. 



SHX = format that allows open 
shapes

1. Download SHX fonts (forum)
2. Add to a folder on your computer
3. LightBurn > Preferences/Settings
4. Set SHX Font Path (to your 

folder)
5. Apply like normal font
6. Can filter by right-clicking font list

SINGLE-LINE FONTS

• Single line fonts need different format to normal fonts 
that word or photoshop would use. 

• This is to support ‘open’ geometry (not enclosed 
shapes) 

• Currently we support SHX. SVG fonts (different to SVG 
generally) are also planned.

• SHX Fonts installed differently, 

• These can be downloaded online, there’s a pack a 
user has provided on our forum. 

• Save Favorite fonts by selecting a font > right clicking 
the font selector > add to favorites. 

More Info

• SHX Fonts:
https://docs.lightburnsoftware.com/latest/Reference/Text/#s
hx-fonts

• Some SHX Fonts to get you started. 

https://docs.lightburnsoftware.com/latest/Reference/Text/#shx-fonts
https://docs.lightburnsoftware.com/latest/Reference/Text/#shx-fonts


• https://forum.lightburnsoftware.com/t/shx-font-collection/25298

https://forum.lightburnsoftware.com/t/shx-font-collection/25298


REMOVE OVERLAPPING LINES
● Laser Window > Optimization Settings > 

Remove Overlapping Lines
● Distance = how close lines need to be, 

in order to be considered ‘duplicate’

● Tells the Cut Planner to remove lines that are 
overlapping between two graphics, and would cause 
the laser to cut in the same place twice.

● The Distance field to the right of the switch controls 
how close two lines need to be in order for the Cut 
Planner to remove one of them when sending the job 
to your laser.

More Info

• Remove Overlapping Lines Documentation
https://docs.lightburnsoftware.com/latest/Reference/Optimiz
ationSettings/#remove-overlapping-lines

• Remove Overlapping Lines Video 
https://www.youtube.com/shorts/tHTnb6MURdU?feature=s
hare

• Grid Array
https://docs.lightburnsoftware.com/latest/Reference/GridArr
ay/

https://docs.lightburnsoftware.com/latest/Reference/OptimizationSettings/#remove-overlapping-lines
https://docs.lightburnsoftware.com/latest/Reference/OptimizationSettings/#remove-overlapping-lines
https://www.youtube.com/shorts/tHTnb6MURdU?feature=share
https://www.youtube.com/shorts/tHTnb6MURdU?feature=share
https://docs.lightburnsoftware.com/latest/Reference/GridArray/
https://docs.lightburnsoftware.com/latest/Reference/GridArray/


REDUCE DIRECTION CHANGES
● Reduce direction changes (slows down)
● Instead of many squares, 

I could do bunch of vertical 
and horizontal lines. 

• Grid Array
https://docs.lightburnsoftware.com/latest/Reference/GridArr
ay/

https://docs.lightburnsoftware.com/latest/Reference/GridArray/
https://docs.lightburnsoftware.com/latest/Reference/GridArray/


● Passes = how many times the laser 
passes over the same section. 

● You can often reduce passes by 
lowering speed and increasing power. 

REDUCE PASSES

Passes: 

• Passes: 
https://docs.lightburnsoftware.com/latest/Reference/CutSett
ingsEditor/LineMode/#number-of-passes

https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/LineMode/#number-of-passes
https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/LineMode/#number-of-passes


● Images (photos, greyscale graphics) 
● Fill areas with flat color
● Remove material from areas

WHEN ‘SCANNING’ IS NECESSARY:



● Fill (large areas) 
● Fill Grouping (all, groups, individual) 
● Flood Fill

● Offset Fill
● Manually ‘broken’ fill

FILL METHODS

These options control which shapes are engraved at the 
same time by the laser. If you run your laser fast, or your 
laser accelerates slowly, it is often most efficient to scan 
things all at once, so the laser spends most of its time moving 
at the speed you've chosen, and less time changing direction. 
If you are engraving slowly, your laser accelerates fast, or the 
design contains a lot of blank space, it can be more efficient 
to fill clusters of close shapes, or to fill the shapes one by 
one.

Fill all shapes at once: The default, this setting means that 
everything on this layer will be filled at the same time, 
sweeping back and forth across the whole job. If you are 
running the laser fast (300 mm/sec or more) this is usually 
the most efficient option, with some exceptions.

Fill groups together: This setting will fill all shapes in a group 
at the same time.



Fill shapes individually: This setting fills all shapes one by one.

Advanced Settings:

Flood Fill: calculates an engraving path that attempts to reduce or 
eliminate travel moves across blank space. It's useful for engraving 
things like large, empty rectangles, where the blank area in the 
middle would consume most of the time spent.

More Info 

• https://docs.lightburnsoftware.com/latest/Reference/CutSettingsE
ditor/FillMode/

https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/FillMode/
https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/FillMode/


● In Device settings. 
● Allows quicker movement through 

empty areas of fill/image engraving. 

FAST WHITESPACE SCAN

This setting boosts your laser's travel speed through blank 
areas of an image engraving, if the speed you set here is 
faster than your laser's engraving speed.

This can save a lot of time if you're engraving an image 
slowly to get a good burn, particularly if there are large blank 
areas in the image.

https://docs.lightburnsoftware.com/latest/Reference/DeviceSe
ttings/BasicSettings/#fast-whitespace-scan

https://docs.lightburnsoftware.com/latest/Reference/DeviceSettings/BasicSettings/#fast-whitespace-scan
https://docs.lightburnsoftware.com/latest/Reference/DeviceSettings/BasicSettings/#fast-whitespace-scan


BI-DIRECTIONAL FILL

• Found in Cut Settings for Fill/Image Modes

• Turns laser around at each end, drastically saving travel 
moves 

• Reasons to have it off: 

• Your laser has slop/starts and ends don’t line up. 

• Unlikely given your machines, 

• but if you do encounter this you can compensate with 
Scanning Offset Adjustment 

More Info: 

• Bi-directional Fill Docs: 
https://docs.lightburnsoftware.com/latest/Reference/CutSett
ingsEditor/ImageMode/#bi-directional-scanning

• Scanning Offset Adjustment: 
https://docs.lightburnsoftware.com/latest/Guides/ScanningO
ffsetAdjustment/

https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/ImageMode/#bi-directional-scanning
https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/ImageMode/#bi-directional-scanning
https://docs.lightburnsoftware.com/latest/Guides/ScanningOffsetAdjustment/
https://docs.lightburnsoftware.com/latest/Guides/ScanningOffsetAdjustment/


LINE INTERVAL
• DPI and Line Interval are linked

• Higher DPI not always better quality

• When lines overlap:

• Images too dark 

• Details muddy 

• Engravings textured

• Higher DPI isn’t better when it causes your scan lines to 
overlap. This will make muddy designs. 

• CO2 actually has rather large beam size compared to 
Diode or MOPA that Tong spoke about yesterday. 

• Ideally you want each line to juuust touch. Use magnifying 
jewelers loop or USB Microscope to assess. 

• Interval or materials test generator tools. 

More Info 

• Fill Mode 
https://docs.lightburnsoftware.com/latest/Reference/CutSett
ingsEditor/FillMode/

• Materials Test 
https://docs.lightburnsoftware.com/latest/Reference/Materia
lTest/ 

• Line Interval Test 
https://docs.lightburnsoftware.com/latest/Reference/Interval

https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/FillMode/
https://docs.lightburnsoftware.com/latest/Reference/CutSettingsEditor/FillMode/
https://docs.lightburnsoftware.com/latest/Reference/MaterialTest/
https://docs.lightburnsoftware.com/latest/Reference/MaterialTest/
https://docs.lightburnsoftware.com/latest/Reference/IntervalTest/


• Test/

https://docs.lightburnsoftware.com/latest/Reference/IntervalTest/


LINE INTERVAL
• Minimize scan lines by increasing 

Line Interval (Layer Settings)

• Defocus increases line width, allows you 
to increase line interval further

• Defocus via Z Offset (Layer Settings)

• Higher Line interval = larger gap between lines = fewer 
lines = quicker 

• Beam has a ‘waist’ smallest at focal point 

• Either side of this the beam gets thicker

• We can use this to make thicker lines and lower out interval 
even more. 



● Very High Line Interval = 
interesting effects

● Combine with Scan Angle 
for slanted lines

● SUPER quick

HACKING LINE INTERVAL

https://youtu.be/KrAQY9wFv2c?si=CbtAy8wpbHl8L65X 

https://youtu.be/KrAQY9wFv2c?si=CbtAy8wpbHl8L65X




TEST FOR SUCCESS
● Built-in Material Test 
● Mini-tests in unused area of job
● Increase power and speed but 

watch out for over-scanning 

• Increase speed AND power (diagram) if available.

• big material test to find optimal (fastest speed with 
results)

• If you run too high the laser has to ‘overscan’ travel 
far outside the bounds, and on narrow jobs this can 
increase your time.

More info: 

• Material Test: 
https://docs.lightburnsoftware.com/latest/Reference/Materia
lTest/

https://docs.lightburnsoftware.com/latest/Reference/MaterialTest/
https://docs.lightburnsoftware.com/latest/Reference/MaterialTest/


LAYOUT IS CRITICAL
● Run more than one job at a time
● Stack multiple objects side-by-side
● Align, Distribute, Docking helpful
● Put tall objects on side

● Layout is critical

○ Layout of jobs (particularly when engraving) 
tall objects, put on side. 

○ Duplicate objects, fit horizontally. Multiple 
objects- stack side-by-side

○ Reduce the red in the preview. halving 
frame-like jobs and fill groups together (e.g. 
clock face)

○ Alignment, Distr



MINIMIZE WASTE
● Test for success
● Prototype in cardboard
● Know your boundaries: Jigs (cardboard)
● Efficient Layout: Docking/Nesting
● Tool Layers to keep track of 

what you’ve used
● Minimize cleanup with masking
● Remove masking with gaffer tape

● Test for Success:

○ Prototype in cardboard 

○ Material tests

■ Big

■ Small around design 

○ Minimise material waste (for precious 
materials)

■ Know your boundaries: Knock up 
corner 

■ Docking & Nesting

■ Tool layer for cut objects 



• Sketch Trace for images with tricky contrast
• Offset out, then back in to make cut lines 
• auto group
• shift+click layer to select everything on it 
• Sort cuts last

DESIGN QUICKLY -TRACED IMAGE

• Sketch Trace 
https://docs.lightburnsoftware.com/latest/Reference/TraceI
mage/#sketch-trace

• Offset out, then back in to make cut lines 
https://www.youtube.com/shorts/2xBJ8XGkp5g 

• auto group: 
https://youtube.com/shorts/mYv92lztU3k?si=FhxfztodHw6ip
AGB

• shift+click layer to select everything on it 

• Sort cuts last by right-clicking layer menu. 

• Cut operations need to happen last in a job, if 
you do them before engraving pieces can shift 
as they fall and your engravings will end up 
offset. 

• Line operations can be cut but can also be 

https://docs.lightburnsoftware.com/latest/Reference/TraceImage/#sketch-trace
https://docs.lightburnsoftware.com/latest/Reference/TraceImage/#sketch-trace
https://www.youtube.com/shorts/2xBJ8XGkp5g
https://youtube.com/shorts/mYv92lztU3k?si=FhxfztodHw6ipAGB
https://youtube.com/shorts/mYv92lztU3k?si=FhxfztodHw6ipAGB


• scored/marked. The difference is the settings. Slow 
and high = cut, quick and low = score. 

• Sort cuts last ranks things based on operation type 
(fills and images first) then orders the lines by their 
speed and power so that the strongest settings will 
be last. 



DESIGN QUICKLY -HANDY TOOLS
• Align, Distribute, Dock
• Array, Virtual Array
• Variable Text
• Tool layers
• Guide lines
• Transform Control Toggles

• Align 
https://docs.lightburnsoftware.com/latest/Reference/Align/ 

• Distribute 
https://docs.lightburnsoftware.com/latest/Reference/Distribu
te/ 

• Dock 
https://docs.lightburnsoftware.com/latest/Reference/Dock/ 

• Array 
https://docs.lightburnsoftware.com/latest/Reference/GridArr
ay/ 

• Virtual Array 
https://docs.lightburnsoftware.com/latest/Reference/GridArr
ay/#create-virtual-array 

• Variable Text

• https://docs.lightburnsoftware.com/latest/Reference/Va

https://docs.lightburnsoftware.com/latest/Reference/Align/
https://docs.lightburnsoftware.com/latest/Reference/Distribute/
https://docs.lightburnsoftware.com/latest/Reference/Distribute/
https://docs.lightburnsoftware.com/latest/Reference/Dock/
https://docs.lightburnsoftware.com/latest/Reference/GridArray/
https://docs.lightburnsoftware.com/latest/Reference/GridArray/
https://docs.lightburnsoftware.com/latest/Reference/GridArray/#create-virtual-array
https://docs.lightburnsoftware.com/latest/Reference/GridArray/#create-virtual-array
https://docs.lightburnsoftware.com/latest/Reference/VariableText/


• riableText/

• https://docs.lightburnsoftware.com/latest/Reference/Variable
Text/VariableTextFormatting/

• Tool layers

• https://docs.lightburnsoftware.com/latest/Reference/UI/Color
Palette/#tool-layers

• Guide lines

• https://docs.lightburnsoftware.com/latest/Reference/Automati
cGuidelines/#alignment-guides

• Transform Control Toggles off scale or rotate to prevent 
mishaps

• https://docs.lightburnsoftware.com/latest/Reference/Transfor
mControls/#transform-control-toggles

https://docs.lightburnsoftware.com/latest/Reference/VariableText/
https://docs.lightburnsoftware.com/latest/Reference/VariableText/VariableTextFormatting/
https://docs.lightburnsoftware.com/latest/Reference/VariableText/VariableTextFormatting/
https://docs.lightburnsoftware.com/latest/Reference/UI/ColorPalette/#tool-layers
https://docs.lightburnsoftware.com/latest/Reference/UI/ColorPalette/#tool-layers
https://docs.lightburnsoftware.com/latest/Reference/AutomaticGuidelines/#alignment-guides
https://docs.lightburnsoftware.com/latest/Reference/AutomaticGuidelines/#alignment-guides
https://docs.lightburnsoftware.com/latest/Reference/TransformControls/#transform-control-toggles
https://docs.lightburnsoftware.com/latest/Reference/TransformControls/#transform-control-toggles


SAVE FOR FUTURE YOU
● Settings to Library
● Designs to Art Library 
● Cut-out pieces to tool layers 



WHEN TO OPTIMIZE?
● When it costs you no extra time: 

○ Optimization Settings 
○ Reusing known settings

● When the time it takes you to set up is 
less than the time it saves in the job. E.g.
○ When doing many similar jobs 
○ When you are running large engraves

● When is it right to spend time optimizing? 



HELP
● Tooltips 
● Documentation. So much documentation. 
● Loads of videos too
● Hover over tool 

& hit F1 (fn+F1 on mac) 



▰ www.LightBurnSoftware.com
▰ Support@LightBurnSoftware.com
▰ Docs.LightBurnSoftware.com
▰ Forum.LightBurnSoftware.com
▰ YouTube.com/@lightburnsoftware7189l




